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Registration Information
    You may use this program for evaluation purposes only. If you decide that you 
would like to continue to use it beyond a 15-day trail period, you are required to
purchase a registered version.
    Upon registering, you will receive a 3½" diskette containing the lastest version of Chord 
Comp (with the opening notice omitted and a 'Save Configuration' option.)

REGISTRATION FORM

Send your name and address, along with a check or money order for $19.95 to:

    Marty Balash
    P.O. Box 858    
    Woodbury,    CT    06798

ChordComp
Version 1.0 



What is ChordComp?
ChordComp is designed to help guitarists understand and create basic chord progressions. 
ChordComp provides a selected set of chords to work with, along with the capability    to 
save, edit, transpose and print chord progressions created with these chords.    

With ChordComp, you can:

Improve your guitar playing and general musical ability by becoming familiar with the 
structure of songs.

Create useful chord charts in any key.

Become familiar with music theory concepts.

Train the ear to recognize the chord progressions in songs.

View and print common fingerings for all major and minor chords.

Print reference materials on your printer.

Work with chord ideas on the Scratch Sheet, where they can be saved, edited, transposed 
or printed.

Guitarists, guitar teachers, bands, composers, students and hobbyists can benefit from 
ChordComp.    ChordComp provides a manageable set of chords to work with, making it 
easier to learn and create chord progressions.



Registration Form
(ChordComp on 3½" diskette)

Name:

Address:

City:

State: Zip:

_____ Copies of ChordComp @ $19.95            =    ____________

Enclose a check or money order payable to Marty Balash. 

Marty Balash
P.O. Box 858
Woodbury, CT 06798



Disclaimer of Warranties
 THE AUTHOR SPECIFICALLY DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO CHORDCOMP. THE AUTHOR 
SHALL HAVE NO LIABILITY WITH RESPECT TO ANY LOSS OR DAMAGE DIRECTLY OR 
INDIRECTLY ARISING OUT OF THE CHORDCOMP. WITHOUT LIMITING THE FOREGOING, THE 
AUTHOR SHALL NOT BE LIABLE FOR ANY LOSS OF PROFIT, INTERRUPTION OF BUSINESS, 
DAMAGE TO EQUIPMENT OR DATA, INTERRUPTION OF OPERATIONS OR ANY OTHER 
DAMAGE, INCLUDING BUT NOT LIMITED TO DIRECT, INDIRECT, SPECIAL, INCIDENTAL, 
CONSEQUENTIAL OR OTHER DAMAGES.    USE OF CHORDCOMP INDICATES THE USER'S 
AGREEMENT.

ONE REGISTERED COPY OF CHORDCOMP MAY EITHER BE USED BY A SINGLE PERSON WHO 
USES CHORDCOMP    ON ONE OR MORE COMPUTERS OR INSTALLED ON A SINGLE 
COMPUTER USED BY MULTIPLE PEOPLE AT DIFFERENT TIMES.



Roman Numerals
Roman Numerals are a convenient way to describe the relationship between chords 
without using specific letter names.

Example: You are learning a song in the key of C that you will later need to play in the key 
of A.    You would play A instead of C throughout the song, but you have found a B Major 
chord in the song.    What is the correlating chord when you move the song to the key of A?

Looking at the chart below, you can see that in the key of C (first row), B is the VII (seven) 
chord.    In the key of A (10th row) the VII chord is G#. 

 Once you know the key of the song and the degree of the chord to be transposed, you'll 
know the appropriate chord to play (G# Major in this case.) 

The Chord Page uses the I, IIm (minor), IIIm, IV,    V, VIm of the major scale. 

For sharps and flats in the roman numerals -- use the "Chromatic Scale".

Major Scale

Key I II III IV V VI VII
(Use down arrow on scrollbar to line up notes with Roman Numerals.)

C C D E F G A B
C# C# D# F F# G# Bb C
D D E F# G A B C#
D# D# F G G# Bb C D
E E F# G# A B C# D#
F F G A Bb C D E
F# F# G# Bb B C# D# F
G G A B C D E F#
G# Bb C C# C# D# F G
A A B C# D E F# G#
Bb Bb C D D# F G A
B B C# D# E F# G# A#







Chromatic Scale
Contains every note. Using the pattern 
illustrated below, you can find the scale 
degree of any chord within a given key.

Key Key Key Key
Note of C of C# of D of D# etc.
C I  
C# I# I     
D II I# I
D# II# II I# I
E III II# II I# etc.        
F IV III II# II
F# IV# IV III II#
G V IV# IV III
G# V# V IV# IV
A VI V# V IV#
A# VI# VI V# V
B VII VI# VI V#
C I VII VI# VI
C# I VII VI#
D I VII
D# I



Quick Tour
Scratch Sheet Demo

 1.)    Select the appropriate sound driver from the 'Sound Device' menu. (If you are using 
the registered version, select 'Save Configuration' so you won't have to do this every time 
you start ChordComp.)

 2.)    Open the SCRATCH SHEET file 'BLUES1.SSF' using the 'Open Scratch Sheet' button.

 3.)    Play some chords on the Scratch Sheet chords by clicking on them with the LEFT 
MOUSE BUTTON.

 4.)    Transpose the Scratch Sheet from 'G' to another key by selecting a new key from the 
'Chord Page' menu.

 5.)    Play some more Scratch Sheet chords    -- this time they will be transposed to the new
key. 

 6.)    If you have a printer, select 'Print/Scratch Sheet' from the 'File' menu to see how 
ChordComp prints Scratch Sheets.    Change the print grouping to 4 instead of the default 
of 3 before printing. (If using the registered version, you may want to save the 
configuration with a grouping of 4, since it is more commonly used.)

 7.)    Examine the structure of the tune by viewing    the Scratch Sheet as roman numerals. 
Select 'Show Roman Numerals' from the 'Scratch Sheet' menu. You can click on the roman 
numerals to play them.    Select the same menu item again to restore the Scratch Sheet to 
normal.

 8.)    Delete a few Scratch Sheet chords by clicking with the RIGHT MOUSE BUTTON on 
each one and selecting 'Delete' from the menu.

 9.)    Append a chord to the end of the Scratch Sheet by clicking a CHORD PAGE chord with
the right mouse button.

10.)    Insert a new chord: 
              - Click on the desired chord in the Chord Page with the left mouse button.
              - Click on the Scratch Sheet chord (where you want to insert) with the right mouse 
button.    Select 'Insert' from the menu.

11.)    Select 'Seventh Chords' from the 'Chord Page' menu    to restore the Chord Page to 
the default display.    Note that this option will clear the current Scratch Sheet,    prompting 
you to save.    Don't save unless you want to keep the changes that you just made.



Using ChordComp
Quick Tour

The Chord Page

The Scratch Sheet

Printing Scratch Sheets & Chord Pages



Left Mouse Button
When clicked over a chord in either    the Chord Page or the Scratch Sheet , the left mouse 
button    plays the chord using the sound card or MIDI device specified in the Configuration 
Menu.



Right Mouse Button
Clicking on a chord in the Chord Page causes the chord to be appended to the end of the 
Scratch Sheet.    Each individual chord is measured as 1 beat when the Scratch Sheet is 
printed.

Clicking on a chord in the Scratch Sheet brings up an edit menu, allowing changes to the 
Scratch Sheet.    The menu has an "Insert" option -- the chord that is currently highlighted 
on the Chord Page will be inserted.    "Delete" will remove the current Scratch Sheet chord.



Chord Page
The Chord Page is on the left side of the screen. It is used to select    chords for composing 
or learning songs.



Scratch Sheet
The Scratch Sheet is on the right side of the screen. It is used to save, edit, transpose and 
print chord ideas.



The Chord Page
The Chord Page
The chord page contains chord names which represent various scale degrees of the Major 
scale.    If you look at a Chord Page you will see that all degrees of the major scale are 
represented, with the exception of the 7th.      This means that six chords on the Chord 
Page spell out a major scale, without the 7th .    
For example, using the chords on the 'C' Chord Page, sharpen the 'Bb' by ½ step to 'B' and 
you have a 'C' Major scale: 'C - D - E - F - G - A - B'.

Recap: 
Chord Page: I IIm IIIm IV V VIm bVII
Scale Degree: I II III IV V VI bVII
Major Scale: I II III IV V VI VII

The Chord Page can be considered one way to learn the notes of the Major scale, but it's 
main purpose to provide a set of chords from which you can build progressions.    It is 
possible to create a progression by randomly choosing Chord Page chords, and still come 
up with a decent song structure.    However, it is a good idea to base your tune on the 'I' 
chord and use it as the 'tonal center' of the tune.

As you click on the chords with the left mouse button, try to concentrate on the roman 
numeral representing the chord, rather than the chord name. Instead of remembering a 
progression as 'C - Am - F - G', remember it as 'I - VIm - IV- V' in the key of 'C'.    Using this 
method, you will be able to play the progression in any key because you have recalled the 
structure of the song, rather than a group of unrelated chord names. 

 Having a Chord Page available, either on-screen or printed, should prove very useful the 
next time you try to make up a tune. Using these chords you'll find that it is easy to play, 
create and improvise great sounding chord progressions. 

More info:
Roman Numerals

Seventh Chords
A second type of Chord Page is available by selecting 'Seventh Chords' from the 'Chord 
Page' menu.    The three additional chord types are I7, IV7, V7. These chords are needed to 
spell out many blues tunes, but aren't displayed by default because the initial eight chords
provide an adequate (and clearer) starting point for composing and learning tunes.

Selecting 'Sevenths Chords' from the menu will clear the current Scratch Sheet.    Save if 
necessary.      

If a Scratch Sheet is created with seventh chords, it can not use the 'eight chord' Chord 
Page.    Likewise, a Scratch Sheet created with the eight original chords cannot display the 
'Sevenths' Chord Page.

Choosing a New Key
The 'Chord Page' menu allows you to choose the Major or Relative Minor key.    Aside from 
displaying a new Chord Page, choosing another key will transpose any chords that are in 
the Scratch Sheet.





The Scratch Sheet
The Scratch Sheet
The Scratch Sheet allows you to 'jot down' chords as you are working with the Chord Page 
(click the right button instead of the left.)    The Scratch Sheet is primarily for preserving 
relatively short chord ideas, but there is no limit to the number of    chords that may be 
entered and saved.

Entering Chords
Chords are entered by clicking the right mouse button on Chord Page chords, causing 
them to be appended to the Scratch Sheet.    

The following applies only if you plan to print the Scratch Sheet, since printing is the only 
area where the chord boxes are grouped.
One chord box should be entered for each beat in the progresssion.    For example, one 
measure of 'C' Major in 4/4 time would be represented by four consecutive 'C' Major chord 
boxes.    One measure of 'C' Major in 3/4 time would be represented by three consecutive 
'C' Major chord boxes. 

More info:
Printing Scratch Sheets & Chord Pages

Deleting a Chord
Position the cursor on the Scratch Sheet chord to be deleted.    Hold the right mouse button
down, and select 'Delete' from the menu.    

Inserting a Chord
Click on the Chord Page chord to be inserted with the left button.    Position the cursor on 
the chord after where you want    to insert on the Scratch Sheet.    Use the right mouse 
button and select the 'Insert' menu option.

Erasing
Select 'Clear' from the 'Scratch Sheet' menu. 

Displaying Roman Numerals
Select 'Show Roman Numerals' on the 'Scratch Sheet' menu.    Instead of chord boxes, the 
roman numerals representing the chords will be displayed.    The numerals may be clicked 
on and played, the same as the chord boxes.

Scratch Sheet Ideas



Transposing
      An important aspect of ChordComp is it's ability to quickly transpose the chords in the 
Scratch Sheet.      

    The keys listed Chord Page menu serve two functions.    The first is simply to select a new
key for the Chord Page, regardless of whether there are any chords in the Scratch Sheet.    
The second is to transpose any chords in the current Scratch Sheet to a new key.    If the 
'Scratch Sheet Modified' message is on, you will be prompted to save every time you 
transpose.    Therefore, it is a good idea to turn this message off if you will need to do a lot 
of transposing.



Printing Scratch Sheets & Chord 
Pages
The 'Print' menu item on the 'File' menu allows you to print either the current Chord Page 
or Scratch Sheet. 

Scratch Sheet Printing
 A printed Scratch Sheet may be used for a number of purposes including:    study 
materials for students and teachers, chord charts for band members, rough outlines for 
songwriters, etc.

When printing a Scratch Sheet it is necessary to specify the print grouping as 3 or 4 (the 
default is 3.)    

The following illustrates the effect of the 'Scratch Sheet Print Grouping' setting (found on 
the 'Configuration' menu):

Chords, as
entered in
Scratch Sheet.

Result of printing the 
above chords 
using a grouping of 4.

Result of printing
the above chords
using a grouping 
of 3.

Note on page numbering:
Since a screen page holds more chord boxes than a printed page, the page numbers do 
not correspond.    Printing will usually produce more pages than are currently displayed on 
the Scratch Sheet.

Chord Page Printing
Chord Pages may be printed and kept for those occasions when it isn't convenient to use a
computer. For example, a printed Chord Page may be a useful reference when composing 
on a guitar or piano. 



If 'Seventh Chords' is checked on the 'Chord Page' menu, then the three additional chords 
will be printed. 

Make sure that you have selected the desired key before printing the Chord Page.    The 
print option will reproduce all data displayed on the Chord Page.



Scratch Sheet Ideas
Create Songs
Choose a key for the Chord Page and create a progression by clicking on the chords with 
the right mouse button.    Decide how many measures of each chord that you want to use 
and enter four separate chord boxes for each measure.      Add or remove chords from the 
progression as needed and print it when you are finished.    Pick up your guitar and polish 
the remainder of tune by trying different rhythms, chord voicings, melodies, etc.

Understand Intervals
Enter the I, IV and V chords in any key.    (For example, C, F and G in the key of C.)    Turn off
the 'Modified Scratch Sheet' warning (using the Configuration menu) and transpose these 
chords to various keys using the Chord Page menu.    Click on the Scratch Sheet chords to 
hear them. Try to guess what the I, IV, V chords will be (and what they will sound like) 
before you transpose them.    Learning these chords in just several keys will improve your 
ability to learn new songs by ear and will provide a starting point for learning music theory.
This can also be done for the relative minor (VIm,    IIm, IIIm) chords, too.    

Learn Songs
With a CD playing on the stereo, try to locate the key of the song by clicking chords, using 
different keys of the Chord Page.    Once the key has been found, it is often very easy to 
sound out the primary chords in the song.    Once you have found as many chords as you 
can, copy them to the Scratch Sheet, print them and work with the song further on the 
guitar.      ChordComp simplifies learning songs because you don't have to recall and play 
(sometimes difficult) chord fingerings and/or attempt to put a capo at the correct fret as 
you attempt to learn the song.    Once the key is located, it's as simple as clicking the 
mouse over the chords.

Create a Second Guitar Part
Create a progression in the key of    'C' and print it on your printer.    Transpose the Scratch 
Sheet to the key of    'A' and print.    Play the two parts with a friend or on 4-track recorder 
-- one guitar plays the 'C' part and the second guitar plays the 'A' part using a capo at the 
3rd fret.

Use MIDI Programs 
There are several MIDI music programs on the market that will create full band 
accompliment based on user-entered chord progressions.    ChordComp makes it easy to 
create your own original progressions for use with these programs.    Copy the progression 
to the Scratch Sheet, print it and enter the chords into your MIDI program. 

Enhance ChordComp Progressions
After working out a progression with ChordComp, play it on your guitar using substitute 
chords.    
For example:

Chord Substitute Example
I I maj7 C Cmaj7
II m II m7 Dm Dm7
III m III m7 Em Em7
IV IV maj7 F Fmaj7
V V7 G G7
VI m VIm7 Am Am7








